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rlng he 2007 Tangerlne soaring contest sponsored by the
' . . Orlando Buzzards. Photo by Peter Jensen.
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In a future issue..
4 1 T and a contest announcement 26
g ; Look forward to a Mark Nankivil walkaround of the
' Soarmg Dlgest Edltorlal " e Morelli M-200, and an announcement concerning the
G - : Australia F3B Open International, 7-8 March 2008.

Model Analysis with XFLR5 27
XFLR5, a “virtual wind tunnel” allows a detailed
investigation of the aerodynamics of a specific
airframe. Francesco Meschia demonstrates all
of the procedures necessary to evaluate the
X-Models 1.9 m Blade V-tail sloper.

A Mid-summer trip to Volksrust ¥
A four-day excursion to Tamatie-Berg for some slope
- flying, related by Piet Rheeders.
A photo by David Copple
Two Tangent ASH-26 models play in the sun.

Have Sailplane - Will Travel

Sloping at Armadillo World Headquarters
Tom Nagel (without a sailplane this time) finds out that . Y
- there actually is a slope site in Austin Texas - Mt. Bonnell. e Gl

24 | At Last... The Troodons are finished!

. ~ Back cover: Piet Rheeders' photo of the incoming
ta small b|rd like dlnosaur but a 3.65 mspan F3J/F5J

- thunderstorm which brought an end to their flying at
“Tamatie-Berg” Volksrust, South Africa, back in December.
(See Piet's article on this adventure starting on page 4.)
Panasonic DMC-LZ5, ISO 100, 1/250 ,sec, 5.6, 37mm
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XFLR5 <http://sourceforge.net/projects/xflr5/> to evaluate
the X-Model 1.9 m Blade will be a most welcome addition to
your library.

During our recent windy and rainy weather here in the
Northwest, we've been able to devote some time to our
Redwing XC project. All that's left to do is get some lead in
the nose to bring the CG forward to the appropriate location.
Unfortunately, it looks like this may take the overall weight to
more than 11 pounds and over the FAI weight limit.

On a similar front, our granddaughter Alyssa is building

a composite sailplane for summer flying. This is to be an
entirely scratch-built enterprise, so there's been a lot of
construction hardware to set up. She started by laminating
tows of carbon fiber for the outer wing panel spar caps,
and is excited to move on to building the fuselage and tail
structures. Alyssa's planning a multi-part article which
document the entire construction process. Watch fgfthat in
future issues of RCSD.

Time to build another sailplane!

February 2008



-SUMNNET

trep to
(Iolksrus E

, -' , I 3 Ay ] : ¥ s N
ar d‘ b 1 1 - -8 i 1
‘,Bse‘,hls Jart with a mighty hea e. Note the whiplash on

e




he long awaited summer holidays everything is green, and sitting on top hoping that we would somehow get our
normally starts in the beginning of the mountain breathing in some fresh fair share of good winds.

of December in South Africa. Most mountain air, admiring the stunning views  This turned out to be exactly the case

companies and businesses here come to  that surround you, and in company of but most of us took a selection of models
girding halt for three to four weeks over some fellow modelers, is alone worthy of 414t could cope with just about any wind
Christmas, and only come to life again in the effort and expense to go there. condition. This included electric park

the first or second week in January. " The BERG club had two groups visiting ~ flyers, HLG gliders, Gentle Ladys, F3B

Although this might not be the best “Tamatle-Berg” recently, the flrst group _.g;ass.sllppers Zagis, Weasels, Hill Bnllys -
me of the year to go slope soaring a S, scale gliders, 1C- powerxgllder

J more members than -wv#*v—«m&‘f' '

ome seriou

g OrG
s
o - o ‘ 7% 3
- o ’l‘ = Tis ‘." )
i r 4 N ' AL .
X &7 s ",-':{ o
/ { Qi o
EA W ROVAR R e ®
- ’Y ; \ ] ; *u_ CL -
e e 4 e it
n / r ; h \‘{ . - \
r &1 \ ! |* 1 ) ‘(_\ ‘ X
i A S0/ ]
-~ g G i X Pe N
" "\ e I %
y | ALY
i T Fe

February2008 =~ S Rl AR TR AN 0 BTN (L W R e ! g 5




6 R/C Soaring Digest



Opposite: The stunning views as seen from the top of
“Tamatie-Berg” Volksrust, South Africa.
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Mike, Glen and myself
(from Durban) set out

in the early morning on
Wednesday the 2nd of
January 2008, and arrived
at Volksrust at around

10 AM. We had to wait,
however until 1 PM before
we could get to the top

of “Tamatie-Berg” due

to a locked farm gate.
This was no problem as
there was no wind from
any direction. This gave
us the time to go to our
overnight guest farm,
situated directly under the
northwesterly slope, to
unpack our baggage and
personal belongings.

Our overnight accommodation situated
directly under the northwest slope.

The 7.5 meter span, 15 Kg, stand-off scale DG500 Elan of Mike May.
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Once we got to the top,

a quick glance of the
northwest slope showed no
promise of any flying there,
and we proceed to the SE
slope and waited for the light
wind to pick up somewhat.

Glen with his light weight
Weasel was the first to

test the air and sometimes
managed to maintain height
for a reasonable time before
he was forced to turn and
land. Other than that there
was nhot anything else that
could stay up in the light to
no wind conditions.

By the end of the day we had
very little flying time, and Izak
Theron from the ETB club
also now joined us.

At round about 4PM we
packed up as the little

wind we had died away
completely. As the sun set
we left the mountain with a
hope that Thursday (Day 2)
would yield better conditions,
and we returned to our
overnight quarters.

No wind on Wednesday, Day 1.

As per normal, and after we refresh ourselves, the braai
(barbeque) fire was started, followed by the by many R/C
flying stories until we could not keep our eyes open any more.
Once you hit the sack you drift of into dreamland just about
instantaneously.
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On Day 2 the morning broke with a partly
cloudy sky and the SMS | received from
my friend Evan Shaw predicted SE wind
later on in the day.

After breakfast, and just in case the wind
did not work, | had two flights with my
IC-power glider before we departed for
the south slope.

Piet launching his
IC-power glider at our
home base before
departing for the day’s
flying on the slope.

This time round we had no problem

with the locked farm gates. Once on top
we quickly assembled our gliders and
then waited as the early morning mist
disappeared and as the sun got higher in
the sky.

As we arrived at the SW slope we found
some more glider pilots joining us —
Herman and Izak from the ETB club, and
Charl and Peter from the club BERG.

12
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Most of us, when we come to
“Tamatie-Berg,” have at least one &
glider that needs to be maidened, as i
we only come here three to four times
a year.

Mike May had a new Jart and also his
big 7.5 meter span DG500 to fly their
first flights, and likewise my Hill Billy.

Mike had his DG500 inspected by
some other big scale R/C glider pilots
to make sure that it would fly first
time.

At around 2 PM the wind pickup
nicely and | did one short maiden
flight with my Hill Billy. Then as the
wind go stronger Mike let lose his
Jart on its maiden flight. The sky was
now getting busier as the conditions
improved as Zagi’s and other smaller
slope ships took to the sky. At last
this was the wind we waited for and
now were enjoying every moment of
it. I got my second flight in on my Hill
Billy and this time around got it on the
step as she cut through the sky.

From left to right: Herman, Izak and his son Shane trimming his HLG. An HGL is ideal for
no wind and low visibility/misty conditions in the early morning on top of the mountain.

Although the air was now good to
launch Mike’s DG500 but he opted
not to fly it because of the limited
landing space on the south slope.

Needless to say we returned to our
accommodation at the end of the day, well
satisfied and happy as can be. For us a half
a day of good slope flying is worth many a
day’s waiting for the right conditions.
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Pre-flight check on Mike May’s new monster 7.5 meter DG500 Elan.

Day 3 (Friday) we had similar conditions ships and managing some reasonable
as Day 1 (Wednesday) and we ended flights. The indications, however, were
up with light winds turning the full 360 that the next day (Saturday) was going to
degrees before ending the day on the be the best day of our visit.

northwest slope flying our light thermal

This happened to be so on Day 4
(Saturday), with the wind direction from
the northwest and picking up ever so
gradually until it got strong enough for
Mike to maiden his big DG500.

16
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Charl launch Mikes’ 3M Swift.

After this flight, Mike was confidant
that the air was now good enough to
fly his 15 Kg monster DG 500 Elan.
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Mike had one flight with his 3M Swift
and was confidant that the air was now
good enough to fly the 15 Kg monster
DG 500.

The launch went well with Glen on the
left tip, Charl in the middle and Peter on
the right tip. Mike was quick to pick up
the left wing that dropped a bit because
of a late release by Glen.

The DG500 then climbed high above
the slope and soared for eight minutes
before Mike became aware of a
threatening thunderstorm on the lee-
side of the hill and decided to land
before the wind changed direction.

The landing was also good as the
powerful flaps slowed the DG500 down
and Mike had to tuck them away for a
moment to retain some speed before
touchdown.

The thunderstorm came closer and
we had to dismantle and pack up
our models in a hurry. [A photo of the
approaching thunderstorm serves as
the back cover for this issue.]

| don’t think that any one of us would
regret this outing, and as for myself |
have flown six of seven models that |
took with me, and so as we drove down
this magic mountain we are already The Berg team just before we departed for home on Sunday morning. From left to
planning the next trip to Volksrust and right: Piet, Glen, Jenny, Charl, Peter, Mike. Middle center: Blake

“Tamatie-Berg.” W

Launching Mike’s 7.5 meter DG500 Elan.
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Tom Nagel, tomnagel@iwaynet.net

Sloping at Armadillo World Headquarters
HSWT in Texas

y brother Terry has a daughter
working on her graduate degree
at the University of Texas in Austin. He
talked me and the wife into joining with
him and his wife for a trip down to Austin
for Christmas. We’d get a chance to
play a little music together, sample the
local margaritas and meet up with his
daughter’s fiancé and family.

| didn’t count on doing any sloping, so

| didn’t take a plane. Accordingly, you
might notice a total absence of anything
resembling an RC slope plane in the
accompanying photos.

At first, Austin did not look too slope
friendly. The locals kept telling me that
Austin was at the south end of Texas
Hill Country. | thought they meant Hank
Hill, because as far as | could see Travis

County looked pretty darn flat.

Then, just before we left town, Terry

took us up to Mt. Bonnell Park, on the
northwest side of town. Mt. Bonnell
turned out to be a limestone cliff rising
almost vertically some 350 feet above the
body of water variously known as Lake
Austin, or Town Lake, or the Colorado
River.

Mt. Bonnell isn’'t much of a mountain, but
it looks like a pretty nice place to slope.
The escarpment faces almost due west,
with maybe a little West-South-West
curve to it at the northern end. You can
access the cliff top by walking up a fairly
gentle slope from the north end of the
park, or up 150 or so stone steps from
the south end of the park.

The best launch sites appear to be

~

just to the north (to your right facing

the slope) of the actual “peak” of Mt.
Bonnell. “Peak” seems a little pretentious
in this setting. What | really mean is, try
launching 50 yards or so to the right of
the highest point of the escarpment.

Mt. Bonnell Park is a relatively small
Austin City Park. There are no facilities,
and no rangers. The barriers at the edges
of the cliffs are sketchy and trails (and

a little trash here and there) indicate the
barriers are not frequently observed.

There is no direct route down to the
base of the cliff, and if you ootch
out to the edge and look down, you
will see upscale, you might even
say Austintaceous, houses along

February 2008
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To Prevent Serious Injury And Property Damage

PLEASE

Do Not Throw Objects, Rocks, Bottles

Or Launch Fireworks
From Covert Park At Mpunt Bonnell
Violations Subject To Prosecution

THANK YOU

the waterfront, built on a series of man-made lake front
parapets. You do not want to send a plane down there.

This would be a good place to slope something with an
electric motor.

The landing zone comes in two varieties: full of tourists

and full of trees. Luckily, the trees are of the Texas scrub
vegetation variety, and not particularly thorny. Landing will
require either dumping it in the trees on the downwind side
of the access trail, or enlisting a spotter to keep the tourists
at bay while you slide in on the gravel and stone access
path.

This would be a good place to slope something foamiferous
with an electric motor.

The very south end of the park affords a great view of
downtown Austin and the Gozer Building. Austin has only
one really tall building downtown, the proper name of which

22
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iS the Frost Bank Tower but |t |OOkS a |0t ||ke the TopoZone - Mount Bonnell, USGS Austin West (TX) Topo Map http://www.topozone.com/print.asp?lat=30.32076&lon=-97.77334...
H

Gozer Building from Ghost Busters. You can see the
Gozer Building from almost anywhere in Austin, so
it is easy to get oriented again if you get lost driving
around town.

Here are some other things to do and see in the
Austin Area:

Armadillo World Headquarters, a restaurant and bar
now known as Threadgill’s, which in the years 1970
to 1980 was home to more bands and more live
music than can be easily contemplated. Everybody
from AC/DC to Frank Zappa played there, with
groups like Asleep at the Wheel, Jimmy Buffet, Dire
Straits, Genesis, Charlie Mingus, Willie Nelson, Linda
Ronstadt, Earl Scruggs and Ravi Shankar filling in the
middle. It is still a great live music venue.

The Broken Spoke: the same, for country music.

The Congress Street Bridge Mexican Free-tailed Bat
flock: bug eating ornithopters by the millions.

The Texas State Capitol Building, which, because
it is in Texas, is actually bigger than the US Capitol
Building.

The Barton Springs swimming hole, a series of warm
springs re-engineered into a year-round naturalistic
two hundred yard long outdoor pool.

South Congress Street: the hip part of town to eat,
drink, shop or be seen. No RC stores, though.

Austin Segway Tours, a gyro-stabilized livery that for
$59 will liberate your inner geek and give you a two-
wheeled tour of Austin.

0 01 0.2 0.3 0.4 0.5mi

UTM 14 617931E 3354966N (NAD83/WGS84)
Mount Bonnell, USGS Austin West (TX) Quadrangle M=5.047

A QuickTime VR 360 degree view from the top Projection is UTM Zone 14 NAD83 Datum G=0.619
of Mt. Bonnell is available at <http:/www.edb.utexas.

edu/teachnet/QTVR/MtBonnell.htm>. W

l1ofl 1/17/08 11:52 PM
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At last..

the TRC)C)DC)ND are ﬁm'/r/fwd!

Simon Nelson, shuttlewash@mweb.co.za

he Troodon (TROE-odon) is a 3.65 meter
span F3J sailplane which can also be
configured as an F5J machine.

The sailplane version weighs 2.2 Kg (77.6
ounces) ready to fly.

The wing chord is 300 mm, with the area
about 35 % more than the Inkwazi, similar to
the Eish, the local F3J plane, described in a
previous issue of RC Soaring Digest.

The laser-cut ribs were done by Paul at
Lasercore in Pinetown. The wing structure
is composed of carbon tube spars with |
beams. The fuselage is of balsa and full
carbon.

The stabilizer is from AMT.

The wing center section includes a D-tube
leading edge, with the whole wing having a
geodesic structure.

Transparent covering allows that interior
structure to be featured. Sorry, will wear a t-shirt next time.
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The V-tail model is the electric
F5dJ version. It has a 480-33
motor, a 15 x10 prop, and a 3-cell
double stack 2200 LiPoly battery.

The name comes from a genus of
relatively small, bird-like dinosaur
from the Late Cretaceous Period.

It’s from a long line of similar
constructed planes. | will be
doing plans, as with all the
others. [ |
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In a fvhnfc 1%ve....

MILANG
2008

Souytnm

Australian F3B Open International
Milang, South Australia
7th 8th 9th March 2008

Three days of F3B action with pilots from
Germany, Japan, New Zealand and Australia

Enjoy a summer holiday
I'\/l " I'\/'I p in South Australia
Ope I - Great conditions with great blokes
Serious early season F3B flying
walk-around

Manufactured by CVT in Italy, this is an 18.15 meter span
two-place staggered side-by-side sailplane which is
stressed for aerobatics and has a 32:1 glide ratio.
Wood construction and a large cockpit make it a good
candidate for RC aerotowing with vario or GPS installed.

Further information and registration of interest
please contact Mike O’Reilly at:
mike@modelflight.com.au
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Nlodel analysis with XFLIRB

Francesco Meschia, francesco.meschia@gmail.com

Virtual wind tunnels and simulators

Many aeromodelers are already familiar
with XFoil, the famous virtual wind tunnel
developed by Mark Drela and Harold
Youngren at MIT. XFoll, like many of its
siblings, simulates with good accuracy
the airflow around a “two dimensional”
airfoil, i.e. the purely ideal case, not likely
to be attained in practice, of an airfoil
section traveling through the air by itself,
without an associated wing, therefore
neglecting induced drag and any other
planform induced effect.

This kind of analysis lends itself well to
the comparison of different airfoils but,
on the other hand, requires additional
work if one wishes to analyze the
performance of a wing or a complete
aircraft, full-size or model, a task that
involves many other variables and
requires careful modeling of many other
factors.

Because of its extreme importance
for the whole aviation industry, the
latter problem was investigated for a

long time, and a numerical method for
aircraft performance analysis, known

as vortex lattice method, or VLM, was
developed since the 1930’s. | am not

an aerodynamicist and so | cannot
describe the VLM in great detail, but
from the Internet | learned that VLM
involves dividing the lifting surfaces into
a fine mesh of panels. Each panel is
surrounded by a horseshoe vortex, that
extends chord wise to infinity; with a few
boundary conditions one can calculate
the lift and drag contribution of each
vortex and so, by summing the individual
contributions, one eventually evaluates
the performance of the whole surface.

Because of its numerical nature, the
VLM didn’t really “take off” until enough
number crunching power became
available, with the advent of computers
in the 1960’s; it proved since then to be
a very powerful tool and it was used to
study and develop a large number of
different aerodynamic configurations.

In the last few years VLM has landed in

the aeromodeling realm, thanks to the
increase in processing power of modern
PCs and to a few suitable software
packages which are now available. Again
Mark Drela and its research group have
released AVL, a powerful and complete
program with a “family feeling” with XFoil
in its command-line user interface. Much
like what happened to XFoil with Stefano
Duranti’s “Profili 2,” VLM has become
more accessible to the non-specialists
thanks to XFLR5, a program developed
by André Deperrois. Mr. Deperrois’s
work includes an interesting contribution:
whereas the “classical” VLM analysis
assumes a purely inviscid flow around
the lifting bodies and is therefore a bit
unrealistic for the Reynolds numbers
used by model aircraft, XFLR5
postulates that the viscous and inviscid
contributions to aerodynamic forces are
linearly independent, so that an inviscid
VLM output may be complemented

by a viscous XFoil analysis to get a

more realistic mathematical model.
Deperrois warns the users, though, that

February 2008
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the “independence hypothesis” is not
supported by a theoretical model, and
so XFLR5 results need to be considered
preliminary and experimental work and
model validation still needs to be done.

XFLR5 users need to keep this
philosophy in mind when approaching
the program. XFLR5 must be “fed”

with both a geometrical model of the
lifting surfaces to be analyzed and

a set of polars derived from viscous
analysis of the adopted airfoils, for

a range of Reynolds number and lift
coefficient broad enough to cover all
flying conditions. In other words, before
even starting XFLR5 the user must find
the coordinate files for all the airfoils
which will be used, and a 3-view of the
aircraft. Also we must remember that
XFLR5 is merely a simulator for a set

of physical behaviors, and can’t tell us
anything about an aircraft but what we
are prepared to ask; it’s a handy tool, but
teaching us how to design a successful
model is entirely out of its scope.

Much better, in my opinion, is to
approach XFLR5 with a practical touch,
to show what the program is capable of
and also what to ask the program for.

| have therefore chosen a well known
model, the 1.9m Blade from X-Models,
and | will use it as a test case to look for
answers to some common questions
such as lift distribution, stability analysis,
and speed polar determination.
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Modeling the Blade

The airfoil used in the Blade wing

is a modified RG-15, which was
thinned from the original 8.9%
thickness to a sleek 7.8%. According
to many modelers, it is likely that

the airfoil evolves into some other
variation near the wing tips, but |
could get no final word about this
and so | will neglect it in my analysis.
With some juggling with cardboard
templates | have determined that

the V-tail relies upon a 7% thick
symmetrical airfoil, a NACA 0007.

The coordinates for the 4-digit
NACA foil may be calculated with

a well-known algorithm, but the
RG-15 coordinates must be found
somewhere in literature. | would
suggest using the airfoil database by
M.Selig and the University of lllinois
at Urbana-Champaign <http:/www.
ae.uiuc.edu/m-selig/ads/coord_
database.html#R> for that.

Once the coordinate file has been
downloaded, we can start XFLR5

and begin our journey by importing

the foil data. From the “File” menu

we choose “Load File” and we

select the DAT file; XFLR5 will show an
outline of the airfoil in the lower pane of
the window (Figure 1). As we can see
the thickness is 8.9% by the book, so it
must be thinned to 7.8% if we want to
model the actual Blade foil. This is done
via the “Scale Camber and Thickness”

%3 XFLR5

File Application View Foll Design Polars Operating Point ?
D|ﬁ|ﬂ|§| E| [re-155.9% R =1 |
2l o e
0.10 =
-
008 Stat=[ 1500
End=[ 1500
006 e
~F
004 P
=
. (e |
) Dl:hy
GGGDG 01 02 0i3 04 a5 a6 o a8 iz 10 -
=
002 e e
Slow Fast
004 =
0.06 =
Shle l—_|
008 ‘width pt —
Caolor |-
Ready Blade 19 new
Figure ‘I Geometry. Pz\
Camber Thickness
Walug Walue
e e e LU v o A
command in the “Design” menu, as 7 % cha [ 78] xcw
shown in Figure 2. M;*;‘Df'"jj PO ';D' S
The airfoil for the tail is calculated by W7 ohad W3 Fehord
a routine that may be invoked with
the “Naca Foils” command under the Restore | oK Cancel |

“Design” menu. We need to tell XFLR5
the NACA number of our choice (0007)

Figure 2
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13 XFLRS [Z)[5)(5) [ Batch analysis for RG-15 7.8%
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Figure 3

and the number of points (100 points
will do). The program will calculate the
coordinates and will draw the airfoil
profile (Figure 3).

Now that we have the wing and talil
airfoils it’s time to use the embedded

XFoil module and compute their polars.

For each airfoil we must compute a
set of polars that covers a range of
Reynolds number representative of
the “flying” conditions. XFLR5 will take
those polars and will add the viscous
contribution to the VLM analysis by
interpolating between computations at

Figure 4

different Reynolds if needed. Care must
be taken so that the Reynolds mesh
coverage is tight enough and XFLR5
can use it. (We’ll see later how to tell

if this is correct and how to extend
coverage if necessary.)

Polar computation might be carried
out manually, Reynolds number by
Reynolds number, but there’s a handy
utility that lets us process a whole
polar family at once. We will begin by

selecting from the airfoil drop-down list
one of the foils (e.g. RG-15 7.8%) and
then choose “Run Batch Analysis” from
the “Polars” menu. A new window will
pop up (Figure 4) where we shall enter
the parameters for the batch run. First
we select the desired analysis type (e.g.
Type 1, that stands for fixed airspeed

30
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%3 XFLR5

File Applicaton View Fol Design Polars OperatingPoint ?

Polar list fg|
R eynolds Mach M Crit

1| 10000f 000 900

2 20000 0.00 3.00

3 30000 0.o0 9.00

4 50 000 0.o0 9.00
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and chord, and variable lift coefficient);
then we enter the desired Reynolds
range (I'd suggest to use a list of Re’s,
like the one shown in Figure 5) and the
angle of attack range (e.g. AoA ranging
from -3° to +9°, in 0.25° steps). When
we click the “Analyze” button the XFoll
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Figure 6

routine will start working and in a little
while will crank out the polars. When

the computation is over we may close
the window, then we open the “View”

menu and choose “Polars.” The newly-

computed polar family will be shown
(Figure 6), and we’ll be able to choose

any plot we’re interested in (Cl vs. Cd, CI
vs. alpha, Cm vs. alpha, and so on) by
choosing the appropriate item in “Polars
> View.”

The same procedure must be re-iterated
for the NACA 0007 tail section (Figure 7),
at first for the same range of Reynolds
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numbers used for the main wing section
and for AoA between -4 and +4 degrees;
theory suggests that we should shift

the Reynolds range towards lower Re’s,
because the tail chord is shorter than the
wing chord, but we’ll see later if this will
actually be necessary.

Now we have the 2D polar families for
both wing and tail sections, it’s time to
enter the realm of 3D simulation with the
vortex lattice method. First we must set
up in XFLR5 a simple three-dimensional
model of the Blade, re-creating the wing
planform, the wing dihedral, the tail with

its planform and decalage. For this | will
use actual geometric data | measured on
my own Blade.

We can enter the XFLRS5 plane geometry
routine first by selecting the “Wing
Design” option from the “Application”
menu, then by choosing “Define a Plane”
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from the “Wing/Plane” menu which will
appear. A window similar to the one
shown in Figure 8 will pop up. In this
window we can assign a name to the
model, we can set the wing and tail
rigging angles (via the “tilt” parameter)
and, most important, we can enter the

Plane Geometry
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T aill Yolume = 04z
Tatal Panelz = ahe

| Z|7ITIITI

Cancel

geometry definition sub-windows. In
these sub-windows (see Figure 9 for
wing geometry and 10 for the tail) we
will model the lifting surface planform by
dividing it up in a series of trapezoidal
panel, and we’ll also need to define a
suitable mesh for each panel for VLM

Figure 8

purposes. A finer mesh means more
accuracy, but we don’t want to take
this too far because we could run into
XFLRS internal memory limitations. |
suggest using the “Reset VLM Mesh”
button after defining all the panels so
that the program defines a mesh it sees
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fit. Each panel is defined
by its airfolil, its root and
tip chords, its span,

its offset, its dihedral
relative to the horizontal
plane, and its twist;
XFLR5 uses metric units
by default, but it may

be set to use the U.S.
system via the “Units”
option in the “View”
menu. (I am from Europe
so | will use the metric
international system in
data and calculations.)
As the data are entered,
the program immediately
calculates the wing
surface, the mean
aerodynamic chord, and
the wing aspect ratio.

The wing of the Blade
has three degrees
central dihedral, that is
1.5 degrees per each
half-wing relative to the
horizontal plane. The
V-tail is modeled in
XFLRS5 as an elevator
without fin: each half-
elevator has 35 degrees
dihedral to the horizontal
plane. | measured a
longitudinal dihedral
(decalage) of one
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degree, which | modeled
by setting the tail at zero
degrees and rigging

the wing at 1 degree,
and the wing has a
negative 0.5 degrees
twist at the outer aileron
edge relative to the root
section.

When we have defined
wing and tail geometry,
| suggest we make sure
that the “Check Panels
on Exit” option is NOT
checked (this option
may sometimes cause
a program crash in
XFLR5 v3.21) and we
can dismiss the window
with the OK button. If we
select the “3D” option
in the “View” menu, a
three-dimensional view
of the model will be
shown, like in Figure 11.
We can also request any
of the three orthogonal
views with the X, Y and
Z buttons in the window
pane at the right.

The 3D polar of the
model

We now are just one
step from obtaining the
3D polar, that is the polar
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Polar. Analysis
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of the whole model. The polar computation requires a set
of boundary conditions, and so we must decide whether
we want to either have constant airspeed, or constant lift,
or constant angle of attack. In the gliding task the wing
must generate, at any given moment, just enough lift to
balance the weight of the model, therefore we are mostly
interested in the second type of boundary condition. We
can tell XFLR5 about our choice by choosing “Define a
Polar Analysis” from the “Polars” menu, and by choosing
a “Type 2” analysis from the window that will pop up
(Figure 11). We must also tell XFLR5 the weight of our
model (my Blade weighs 1450 grams) and the position

of the center of gravity (“moment reference location” in
XFLR5 jargon) relative to the leading edge of the wing
root that is taken as the coordinates’ origin (79 mm for
my Blade). From the same window we notice that VLM is
the only applicable analysis method (the other one, the
lifting line theory method or LLT, can only be used for

an isolated wing, i.e. without tail) and we need to make
sure that the “Viscous” option is checked. That said,

we can dismiss the window with the OK button and we
are ready to run the computation task. In the rightmost
window pane we set up a sequence of angles of attack,
for instance from -2°to 7° in steps of 0.25°, we check the
“Store OpPoints” and “Store points outside the polar
mesh” boxes (see Figure 12) and we can start the job

by clicking the “Analyze” button. A window will pop up
with a processing log and maybe some final messages
warning us that some operating point fell outside the
polar mesh. We’'ll see later what those log messages
mean, for now we want to jump directly to the results.
We choose (if not already done) the “3D” option in the
“View” menu and we are presented with a beautiful color
rendering of the distribution of the pressure coefficient
over the lifting surfaces (Figure 13). By altering the angle
of attack via the drop-down menu in the upper right part
of the window we can see how the pressure distribution
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changes its shape accordingly.
Undoubtedly impressive, but somewhat
hard to decipher because on the same
plot we can find lift vectors, drag vectors
and also downwash vectors. A number
of different output modes for the same
data are available, equally interesting
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and maybe easier to understand if a
little less appealing. For instance, we
may choose “Polars” from the “View”
menu, then we right-click on the graph
that will appear and last we choose
“Graph” and then “Variables” from the
pop-up menu. We’'ll be presented with a

list of variables we can assign to X and
Y axes. If we assign vertical velocity (Vz)
to Y axis and airspeed (Vinf) to X axis
we’ll get the speed polar for our 1.9m
Blade (Figure 14). This graph pictures
the relationship between airspeed and
sinking speed, which is a true snapshot
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of the performance of a glider, be it
full-size or a model. It is worth noticing
that the plot has a minimum sink point
which corresponds to an airspeed value
slightly above stall speed (theoretically
speaking, the 1.9m Blade could attain a
sinking speed as low as 40 cm/s at an

airspeed of about 10 m/s), and another
point, different from the former, for which
the horizontal-speed-to-vertical-speed
ratio (also known as efficiency and glide
ratio) has a maximum (at 11 m/s airspeed
for our Blade). These two points picture
two very important attitudes of a glider:

the pilot who wants to stay aloft in dead
calm air for as long as possible must trim
the sailplane to keep the minimum sink
airspeed, whereas the pilot who wants
to travel as far as possible must trim for
maximum glide ratio.

Another, clearer, way to study the glide
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ratio versus airspeed relationship is to
ask XFLR5 to assign the “Glide Ratio CI/
Cd” to the Y axis while keeping airspeed
(Vinf) on the X axis. The resulting chart
(Figure 15) immediately displays not
only the maximum glide ration point,

but also the numerical value of the ratio,
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Figure 15

which is theoretically above 25 at 11

m/s airspeed. The peak is well defined,
that means that any drift from optimum
airspeed translates into a marked loss of
efficiency.

We should now ask ourselves how fast
the Blade wants to fly, that is what its

trim speed is in normal conditions. The
answer is readily found by asking XFLR5
to plot a pitching moment coefficient
versus airspeed chart (Figure 16). We
see that the curve crosses the horizontal
axis at an airspeed of about 18 m/s. This
point is the only balance point for the
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whole flight envelope of our glider, since

here the model does not experience
any pitching moment, neither upward
nor downward. The model simply
flies undisturbed at 18 m/s: this is its
trim speed with neutral elevator trim
and 1 degree of decalage. The curve

also suggests that any higher speed
would cause the Blade to pitch up and
decelerate, and any lower speed would
make it pitch down and accelerate. That
means that we have chosen a center of
gravity location that allows for a stable
equilibrium (but we’ll see more about

stability later).

It is rather conspicuous that 18 m/s is
significantly faster than both 10 m/s
(minimum sink speed) and 11 m/s
(maximum glide ratio speed). This is
consistent with the kind of flight the
Blade is made for. It’s a fast glider
and not a thermal duration model, a
runner and not a floater. It wants to
“sting like a bee” rather than “float
like a butterfly.” It does not make
much sense to force it to fly at the
minimum sink airspeed, and its pilot
is probably willing to trade some
efficiency for more thrill. At 18 m/s
(40 mph) the Blade sinks in the air

at a rate of a 1.1 meter per second.
That means that a slope updraft with
a vertical velocity component of just
above 1 m/s (fairly common for most
slopes) will be enough to keep it

flying.
The lift distribution

We will now talk about another

way to look at the results of XFLR5

computations. So far we have
looked at charts that are a picture of
the behavior of the whole model as a
function of one of the flight variables.
Each point in the curve is an “operating
point” of the model, that is a collection of
data for lift, speed, efficiency, moment,
etc., computed for one particular value
of the independent variable we have
chosen for our analysis (i.e., in our
examples, the angle of attack). But
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the vortex lattice analysis does

not merely yield a “point,” a scalar
value representing the entire model,
but rather it produces a far richer
collection of data, spread across the
many panels that make up the lifting
surfaces. XFLR5 lets us “drill down”
in every operating point by looking at
the aerodynamic parameters in their
distribution over the lifting surfaces.

This kind of study is very interesting,

a true fundamental exercise in
computational aerodynamics. If we

look at the lift coefficient at which

every wing “station” is working,

from the root all the way to the tip,

we can easily see what parts of the
wing are working “harder” (higher

lift coefficient) to produce lift and,
therefore, will be the first to come to a
stall according to the viscous analysis
we performed with the XFoil module

at the very beginning of the journey.
Let’s pull down the “View” menu and
choose “Operating Point.” We should
get a plot like the one shown in Figure
17, that is a set of curves that picture
local lift coefficient versus position
along the half-wing span, for a range

of angles of attack. If we prefer, we can
also examine just one curve, at a defined
AoA, by right-clicking the chart area and
choosing “Show Only Current Opp” and
then choosing the desired AoA from the
drop-down list in the far left end of the
toolbar.
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Figure 17

When we inspect the family of lift
distribution curves we see that for small
AoA’s (up to 2 to 3 degrees) the portion of
the wing that generates the highest lift is
located at about one foot (300 mm) from
the wing root; but if we further increase
the AoA the tips are forced to work at a

higher and higher lift coefficient, so that
eventually we shall have the dreaded tip
stall.

To see this in greater detail, we need to
take one step back and take a look at the
error messages in the polar computation
log file (“Operating Point” menu, then
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“View Log File”); at the end of the file we

should see a similar message:

...Alpha=5.75

Calculating induced angles...
Calculating aerodynamic coefficients...
Calculating wing...

Span pos = -937.49 mm, Re = 23 308,

Cl = 0.86 could not be interpolated
Span pos = 937.49 mm, Re = 23 308,
Cl = 0.86 could not be interpolated
Calculating elevator...

What this message is telling us is that,
at an AoA of 5.75° the wing tip station
(937 mm, or about three feet, away from

the wing root) ought to generate a
lifting coefficient of 0.86 at Reynolds
23308. According to the XFoil polars
in its memory, XFLR5 doesn’t think
that our modified RG 15 airfoil can
accommodate such requirements.

In other words, XFLR5 foresees the
beginning of a tip stall at this angle
of attack. XFLR5 may not always

be right (in this particular case,

if we examine the family of airfoil
polars we can see there’s such a
wide a gap between the Re=20000
and Re=30000 polars that XFLR5
interpolation might not be able to
bridge reliably), but it is an interesting
clue nevertheless. It is also worth
mentioning that, despite XFLR5’s
opinion, the “real” Blade is not
particularly prone to tip stall problems
(or, at least, it hasn’t yet played

such bad tricks to me). This might
support our initial suggestion that, at
the wing tips, the RG 15 foil evolves
into a different section, one that can
generate more lift at low Reynolds
numbers.

Another variable we might want to
examine the distribution of is local
lift (not lift coefficient). This is the force
that is generated by every wing portion;
it is important because, according
to Prandtl’s theory, the induced drag
contribution for a given wing area is
minimized whenever the lift distribution
shape is elliptical. We can ask XFLR5 for
this distribution by right-clicking on the
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graph area, then choosing “Variables”
and finally “Local Lift C. CI/M.A.C.”
The resulting curves (Figure 18)
closely follow an elliptical arc (a true
elliptical arc may be superimposed to
the plot via a specific option from the
right-button menu), and prove that
the Blade wing planform is backed by
a good amount of careful design and
study.

Analysis of pitch stability

We now want to use XFLR5 to
approach another classical problem
in aircraft performance, that is the
study of pitch behavior and static
stability conditions. Stability, in this
context, is the tendency of the aircraft
to keep its pitch attitude against any
disturbances that may arise (wind
gusts, for instance).

We start this chapter by returning

to the polar plotting mode (View >
Polars) and by instructing XFLR5
(right-click > Graph > Variables) to

plot the pitching moment coefficient
versus AoA. We will get a chart like

the one shown in Figure 19 - a simple
monotonically decreasing curve.

The slope of the curve is “negative” (i.e.
the curve is decreasing) for every point
we have considered. This is of extreme
importance because it is means that
the configuration we have chosen for
the model is stable for all the AoA’s of
our interest. This is easily understood
if we review the physical meaning of
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Figure 19

the chart. First of all, the chart is telling
us that the model glides in balance
(i.e. CM is null) at an angle of attack of
approximately -0.5 degrees. Let’s now
suppose that the flight is disturbed by
a gust that forces the model to take a

greater angle of attack, for instance zero

degrees. The chart shows that at zero
angle of attack the model develops a
negative pitching moment coefficient,
i.e. it “feels” a nose-down moment that
tries to push the wing to its original AoA,
and therefore the model is longitudinally
stable. Every configuration for which the
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moment coefficient versus AoA curve

is decreasing from left to right is stable;
on the other hand all configurations with
an increasing CM vs. AoA curve are
unstable, because every disturbance
results in a pitch unbalance that tries to
further increase the disturbance effect.

The steeper the slope of the CM vs. AcA
curve, the greater the stabilizing or de-
stabilizing action will be.

If we want to decrease a model stability,
or even make it unstable, we just need
to move the CG aft; we can test that

by computing a new polar and placing

the CG at 100 mm from the leading
edge. The resulting CM vs. AoA curve
will be like the green curve in Figure
20: it is a monotonically increasing
curve, and therefore the model will

be unstable for any AoA in the flight
envelope.

We can take this even further by
tracing other Cm vs. AoA curves for
other CG locations. For instance,
in Figure 20 | have also plotted (in
blue) the curve that corresponds to
a Blade balanced at 95 mm from the
leading edge. This one is no longer
monotonic but has a maximum at
about two degrees. Balanced in this
way, the model is neutrally stable.
Strictly speaking, it will be neutral
only at the angle of attack for which
the dCM/dAo0A derivative is null, but
in practice the CM shows such a
slight variation, and for such a broad
range of AoA’s, that the stabilizing
or de-stabilizing effect may be
negligible. The model is not willing to
react to any disturbance, but will fly
at and maintain any angle of attack
we can trim it to. As a consequence, it
will require a pilot’s constant attention
and input, and personally | would not
enjoy flying it at a slope with a brisk
breeze.

The use of camber flaps and
variable camber

The Blade, like many other gliders, has
control surfaces (inboard flaps and
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outboard ailerons) along the whole
wingspan. This configuration allows
for changing the wing camber in flight
by taking advantage of the transmitter
mixing capabilities.

What'’s the use of this feature?
Generally speaking, any variation in
wing camber results in a modification
in the polar curve, and in particular
results in an upward or downward
shift of the Cl vs. AoA curve while
keeping the difference in drag at a
minimum. Some airfoils are more
suitable for this task than others,
but the idea is that variable camber
lets the pilot optimize the model

for different flight conditions, thus
extending its envelope.

It goes without saying that we are
extremely interested in investigating this
kind of optimization. We will therefore
use XFLR5 to analyze different camber
configurations, and then we will compare
them against each other to find what is
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Figure 22

the best setup for different conditions.
Our first step will be to go back to the
XFoil routine (Application > XFoil Direct
Analysis), then choose the RG-15 7.8%

airfoil from the airfoil drop-down list and

invoke the “Set Flap” command from
the “Design” menu. From the window

that will pop up (Figure 21) we check the
“T.E. Flap” box, then we input the desired
deflection angle (we can start with +2
degrees, i.e. 2 degrees of downward
deflection of the trailing edge flap) and
the hinge position as a function of the
chord (approximately 77.5% for the Blade
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wing flaps) and of the airfoil thickness
(100% in our case, because all wing
control surfaces in the Blade are top
hinged); then we click the “OK” button

and we store the modified profile under

a suitable name (for instance, “RG-15
7.8% +2”). Now we must pre-process

the polar family exactly like we did for
the unmodified airfoil, and we might
also want to repeat the whole process
for a broader range of flap deflection
angles (in addition to 0 and +2 degrees,
| suggest +4, -2 and -4 degrees). Now,
if we look at the ClI versus AoA and Cd

versus AoA plots (View > Polars, then
right-click > Graph > Variables) we
will probably see a tangled mess of
curves, but if we clean up things a bit
(Polars > Hide all polars) and then we
plot only a single Reynolds number
for each airfoil modification (by
choosing the airfoil and the desired
Re from the drop-down lists in the
toolbar, then checking the “Show
Curve” box) we should see a graph
like the one shown in Figure 22. This
graph shows that, in a limited AocA
range, different flap settings result in
a conspicuous variation in Cl, with a
limited influence on Cd.

We might now feel the temptation
to see what flap setting allows for
maximum CI/Cd ratio, but we must
always keep in mind that these
are the 2D polars, and the results
may not be immediately translated
into performance prediction for the
complete model. My suggestion
is to spend some more time and
“persuade” XFLR5 to simulate the
complete model with differently
cambered airfoil sections, so that our
investigations will be based upon a
3D model of the plane behavior.

To set up a 3D model of the Blade
with flapped airfoil, first we shall enter
the 3D module of the program (via the
“Application > Wing Design” menu).
Then we recall the already-processed
Blade model via the drop-down list
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in the toolbar, and we duplicate it
(“Wing/Plane > Current Wing/Plane >
Duplicate”), we assign a new name to
the new copy and, via the geometry
definition routine, we modify the

wing by choosing one of the flapped
airfoils (for instance, “RG-15 7.8%

+2”) for all the wing stations from

the root through the 850 mm station
(which corresponds to the aileron
outer tip). After we’ve finished, we
dismiss the window, we process the
3D polar with the same procedure
we’ve already been through, and we
jump to the polar graphs. The speed
polar (Figure 23) is now telling us that
two degrees of flap deflection result

in a small improvement in sink rate for
airspeeds below 10 m/s, but things
get rapidly worse for higher airspeed
values. Glide ratio is also worse in all
the speed envelope but in a small arc
between stall speed and10 m/s. This
means that dialing in two degrees of
flap deflection to increase the wing
camber of the Blade is a good idea
only if we plan to slow the model

down to about 10 m/s. Should we
want to do so? The answer is not so
easy... it is common knowledge that the
Blade doesn’t like to be slowed down,
and undoubtedly it is no F3J model,
and flying at the minimum sink rate

is not its intended best. But in some
cases, sinking at 50 cm/s instead of 70
cm/s may make the difference between
returning safely to the landing zone and
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sticking the model up in some tree top;
in these cases we may want to slow the
model down and dial some flaps, even
if flying at the minimum sink airspeed

is not a funny exercise. Why? Just look
at how close to stalling is the minimum
sink airspeed. If we slow below 9 m/s

the model will stall; if we fly faster than
10 m/s we will not be attaining minimum
sink. Increasing camber makes this more
and more critical, because it makes the
polar curve “narrower” and “sharper.”

There is also another effect to be
considered. If we look at the CM vs. Vinf
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graph, Figure 24, the curve shows that
the zero trim airspeed is about 15 m/s,
slower than the trim speed for when

no flaps were used, but faster than our
target speed for which more camber is
useful. This means that we should also
dial some up trim to make the Blade fly

as slow as required. But there’s a catch:
as we trim the model in this way, the
pitching moment to airspeed relation

will change, and in particular when

we trim for “nose up” the model will
become more pitch-sensitive to airspeed
changes. This will result in a stronger

tendency to oscillate around the
desired airspeed rather than keep it
throughout the flight.

This behavior can be investigated via
XFLR5 by creating a modified NACA
0007 airfoil with a leading edge flap at
75% chord, deflected by -1.5 degrees
(upward deflection, that is), and
instructing the program to simulate

a Blade endorsing this airfoil section
in its V-tail. We will get a CM vs. Vinf
graph like the one shown in Figure 25.
The model with “up trim” (magenta
curve) is now balanced at an airspeed
of less than 10 m/s, but the slope

of the curve near the balance point

is much steeper than the slope of

the curve that describes the “zero
trim” Blade (blue curve) at the 15

m/s balance point. This means that,
for instance, any drift from the trim
airspeed for the “trimmed up” Blade
will result in a pitch response three
times stronger than we would have
with the neutrally trimmed model;
therefore, we may expect a stronger
tendency to pitch oscillations.

Obviously there is a way to get the

model to balance at 10 m/s without
requiring so much up trim; we just need
to move the CG aft. If we re-compute the
model polar by setting the CG at 88 mm
from the leading edge, we see that CM
goes to zero at the desired airspeed of
10 m/s (Figure 26), and that the slope of
the curve is not too step, as predicted.
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Flying with a such a rearward CG,
though, may be challenging and
may even hide any improvement (the
model can really fly “by the polar”
only if it’s not disturbed by pilot input,
and this is not compatible with too
aft a CG). This means that the “best”
combination of CG position and
pitch trim (or decalage) results from
a trade-off between aerodynamic
behavior and pilot skills. A model

set up with a rearward CG is more
pitch-sensitive and may be trimmed
for a broad range of airspeeds, but it
demands the hands of a keen pilot;
a more forward CG likes to fly at an
airspeed only, is less versatile but is
easier to fly. When one is involved in
competition flying, the temptation of
moving the CG more and more aft is
always strong. At first the model will
become more versatile and suitable
for different tasks, but at the same
time it will be less easy to fly, and
sooner or later the pilot will that he
is losing performance instead of
improving.

The very same method we have just
applied may be reiterated for more

flap settings, yielding a broad family

of model polars. If we complement the
two polars we already have with others,
calculated for flap deflections of +6°, +2°,
-2° -4°, and then we ask XFLR5 to plot
all the speed polar and glide ratio curves
in a single chart, we will get something
similar to Figure 27. If we look closely,
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Figure 26

these graphs are very interesting. For
instance, we can see that there is no
single flap setting which is consistently
better than others in the entire speed
envelope. And, perhaps less obvious,
we also see how difficult it is to design
and fly a true “multi-task” model. Flying

at the minimum sink rate (or, in other
words, flying as long as possible) is not
the same as flying at the best glide ratio
(or flying as far as possible), even in still
air. It is part of a pilot’s skills to tailor his
flying style to the particular task and to
the particular weather conditions.
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Trade-offs and conclusions

By looking at Figure 26 we see that

the 1.9-m Blade has its peak efficiency
(best glide ratio) when flying at about

11 m/s (25 mph) with “flat” wing (no
flaps deflected), and that when we want
to descend as slowly as possible we

need to deflect the leading edge flaps
by 4 degrees downwards and keep an
airspeed of 9 m/s (20 mph). We already
mentioned that the Blade is a slope
model, designed to fly fast and that
probably nobody would want to fly it at
the minimum sink or at the best glide

airspeed, especially at a turbulent
slope where it would be virtually
impossible to tell the former from
the latter. But, just for fiction, let’s
suppose we want to bring our Blade
to a thermal duration contest on a
flat field. In this case it’s easier to
distinguish the two flight conditions,
each in its own particular “task.”
We will seek the best glide ratio
when we want to explore as much
air mass as possible while hunting
for a thermal, and we will struggle to
fly at the minimum sink rate in dead
air, where there are no thermals to
be found, or while we are trying to
gain as much altitude as possible
in a weak thermal. In addition, if we
need to penetrate headwind or to
escape from a sinking air zone, it is
also important to fly faster than the
best glide ratio airspeed. In other
words, it becomes important for a
pilot to exploit the “extended polar”
of its model, that is the curve arising
from the envelope of the many
different polar curves associated with
variable camber. To be successful
in this, we need to study the curves
and match the theoretical capabilities
of the model with our piloting skills. For
example, from the charts we see there
is hardly any gain, either in sink rate
or in glide ratio, when we deflect the
leading edge upwards by more than two
degrees; this may be translated in a radio
setup that will allow for a “speed” flight
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phase with no more than two degrees of
up deflection for both flaps and ailerons.
Conversely, the charts suggest that we
may improve the sink rate by deflecting
the leading edge downwards by 2, 4

or even more than 6 degrees, but... the
more deflection we use, the narrower
the polar curve will become, and the
closer to stall the operating point will

be. The pilot must find out how close

to the limit he is still comfortable, and
able, to fly; in any case we have seen
that slowing down the model either
requires a good amount of up trim (or,
equivalently, a rather large decalage), or
requires moving the CG aft. In the former
case we’ll have a more marked tendency
to oscillation, in the latter we will have

a more pitch-sensitive model. Only

the pilot, with his own judgment, can

tell the difference between “sensitive,”
“responsive,” “critical” and “dangerous.”
In my Blade | have decided | see very
little improvement in more than two
degrees of downward flap deflection, and
so | have setup a “thermal” flight phase
accordingly.

There is an additional possibility which

is worth mentioning, that is using the
so-called “snap-flap” mix. This mix,
available in most modern radios, causes
a variation in the “camber” signal (which
is then mixed and sent to flap and aileron
servos) whenever the pilot acts on the
pitch stick. In my opinion it is a good
idea, and not only for fast F3F models

in which it is typically used. When we

pull on the yoke of a glider, in fact, we
are shifting the operating point towards
lower airspeeds, and we have seen that
increasing wing camber at the same time
may be a good idea. The snap-flap mixer
may be seen as a semi-automatic way

to choose the most suitable polar for

the conditions we are “requesting” with
the pitch control. Setting up the snap-
flap mixer is not trivial, but again a good
simulation of the plane behavior, paired
with a good understanding of what we
are asking the model for in terms of
airspeed and load factor, may be helpful.

The last thing I'd like to discuss is how
XFLRS simulation compares with reality.
I’ve had the opportunity to test a flight
data recording system by Eagle Tree
Systems. Unfortunately | could not install
it in my Blade (too narrow and crowded
fuselage) but I used it in my F3J Stork 2
Pro model. With its static and dynamic
pressure ports (the latter connected to
a dynamic probe outside the boundary
layer), the data recorder samples
airspeed and barometric altitude ten
times a second, so that the collected
information may be analyzed offline on
the PC. I’'ve been glad to discover that
the minimum sink setup (very important
in an F3J model), that | had honed in
several test flights, is consistent with the
Stork behavior simulated with XFLR5.
Camber settings for thermal flight, fast
flight and towing were also comparable
to those suggested by XFLR5. | was
less satisfied with the predictions of the

elevator deflections required for minimum
sink and best glide airspeeds, but | later
found that these are consistent with the
not-so-good accuracy (half degree) of
the homebuilt incidence meter | used to
measure the rigging angles of the main
wing and the V-tail group.

My conclusion is that a simulator such
as XFLR5 may be a valuable and useful
tool, provided that the user knows what
to look and ask for, and that he always
keeps in mind the limitations of the
underlying mathematical model and the
finite precision both of our tools and of
our beloved planes. &

XFLRS

Author: André Deperrois

Link: http:/xflr5.sourceforge.net
License : open source GNU General
Public License

Current version as of print date: 3.21e

Blade 1.9

Maker: X-Models

Wingspan: 190 cm (75 in)

Length: 107 cm (42 in)

Airfoil: modified RG-15 (thickness
7.8%)

Wing surface: 32 dm? (3.44 sq ft)
Typical ready-to-fly mass: 1400-1500 g
(49-53 02)
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